Microsoft Outlook 2010™
A Beginners Guide

Contents

Introduction .................................................................................................................. 1
Opening Outlook ........................................................................................................ 1
Using the Calendar .................................................................................................... 2
  Creating an Appointment ......................................................................................... 2
  A Recurring Appointment/Event ............................................................................ 4
Changing the Calendar Layout, View and Other Defaults ................................ 5
  Working with the Date Navigator ........................................................................... 5
  Changing the Calendar View ................................................................................. 6
  Other Calendar Defaults ....................................................................................... 6
Organising a Meeting ............................................................................................... 7
  Checking the Scheduling Assistant ....................................................................... 9
Dealing with an Invitation to a Meeting ................................................................. 10
Using the Email System .......................................................................................... 11
  Adding a Signature ............................................................................................... 11
  Using AutoComplete ......................................................................................... 12
Setting which Address List Shows First ............................................................... 13
Tips on Using your Mailbox .................................................................................... 14
  The Reading Pane and Preview .......................................................................... 14
  Show as Conversations ...................................................................................... 15
  Using Coloured Categories ................................................................................. 16
  Rules and Alerts .................................................................................................. 16
  Favourites .............................................................................................................. 17
  For Follow Up Folder .......................................................................................... 18
Blocked Attachments ............................................................................................... 19
Away from the Office ............................................................................................... 19
Using Contacts ......................................................................................................... 21
  Adding a New Contact ......................................................................................... 21
  Current View of Contacts ................................................................................... 22
Adding an Address from an Email ......................................................................... 22
Sending an Email to a Contact ............................................................................. 22
Setting up a Task ..................................................................................................... 22
Further Information ................................................................................................. 23
These notes are specifically for the CSTD Training Course, Introduction to Using Outlook, and are best used in conjunction with this course. Some of the information can be used and applied, by those who are not on the course, to their PCs on campus that also use Microsoft Outlook.

**Note:** This document assumes that you are familiar with using a windowing system (with its icons, menus and a mouse) and know the procedures of pointing, clicking, double clicking, dragging and multi-tasking.

**Introduction**

It is assumed that the course attendee knows how to login to a PC that is in a University PC Facility managed by IT Services.

Please make sure that you login to the PC with your username and password.

**Opening Outlook**

To open Outlook:

1. On an ITS PC, click on [Start] in the bottom left-hand corner of the screen followed by All Programs, and Microsoft Office Outlook 2010 towards the top of the list (on your own PC, there may be an Outlook icon on the taskbar or the desktop or, if this is not showing, then click on [Start], All Programs, Microsoft Office and finally Microsoft Office Outlook 2010)

2. The first time that you use Outlook 2010 on an ITS PC or on your own PC, follow the instructions given in Using Outlook 2010 & 2007 for the first time (http://www.reading.ac.uk/internal/its/help/its-help-email/its-staff-email-2010/its-exchange-2010-outlook.aspx)

3. Once Outlook starts, the opening screen should look similar to below:

![Opening Outlook Screen](image)
Using the Calendar

The Calendar is one of the most useful areas within Outlook. You can use it to keep track of both work and personal appointments, one-off or recurring appointments, give reminders to yourself of important events or dates, and setup meetings with others.

Creating an Appointment

To get to the Calendar in Outlook, click on the [Calendar] button in the Navigation Pane located in the bottom left-hand corner of the Microsoft Outlook window, just underneath the [Mail] button. Your screen should look similar to the following:

Let's put in an appointment for a bit later today. There are a few ways to create an appointment, but perhaps the easiest/most visual way is as follows:

1. Depending on the time of this training session, click in the main Calendar grid (choose a day if you are in Week view) next to either 1100 or 1500 to select the time for your appointment - this selected area on the Calendar (a half-an-hour slot) should go blue (if you want a longer slot/time, just drag down on the mouse to include the next half-an-hour or more)

2. Right click on the selected blue area and choose New Appointment from the shortcut menu - you should get a window similar to the following:
3. An **Appointment** window will open in which you can enter a subject, location and description, along with other information. For the **Subject**, type in **Outlook Training Session**

4. Move to the **Location** box (either use the mouse or press the `<Tab>` key next to the letter Q on the keyboard) and type in the name of your training room, e.g. Sail 108 (after you have entered a few appointments in different rooms, you will find that you have a list of rooms to choose from)

5. You should find that the **Start time** and **End time** have already been setup according to your selection earlier, but you can still change these at this point. Note the **All day event** box - clicking this box means that your appointment becomes an all day event, and the start and end time boxes disappear as well as the reminder going to 18 hours before

6. In the large window/area below the **End time** box is where you can write a further description - put what you like here, or if you can't think of anything, try **This is the CSTD course I booked onto to learn more about using Outlook!**

7. On the **Appointment** ribbon at the top of the window, in the **Options** group, you’ll find some useful boxes and icons. The **Show As** box is very useful as it tells not only you, but also other people who might be looking at your Calendar if you are busy or not at this time. The default setting is usually Busy. For this training session, click on the down-list arrow and select **Out of Office**

8. The **Reminder** box allows you to set whether Outlook should remind you of the appointment. This can be very useful, and the default setting is set to remind you 15 minutes before the appointment. Click on the down-list arrow to select a different reminder time, or none, if you want. The reminder will come up later on your screen (assuming you have Outlook still running) as a window similar to below (one option is to snooze it to remind you again later, a bit like what you can do with a morning alarm clock!):

   ![Reminder Window](image)

9. You can give an appointment a category (at the same time making it more visible in your Calendar as it will have a different colour) by clicking on the **Categorize** icon and then choosing one of the categories from the list (you can change the default label settings and setup your own ones)

10. Click on the **[Save & Close]** icon at the start of the **Appointment** ribbon - you should find that the appointment is now setup in your Calendar in a different colour with a small vertical purple/mauve bar on the left-hand side, indicating that you're out of the office at that time

**Note:** You can also turn an email message that you receive into an appointment (or meeting) on your Calendar by dragging the message onto the **[Calendar]** button in the Navigation Pane (the appointment is set to the next available slot on that day, with the subject the same as the subject of the email, and the email message filling out the description of the appointment).
A Recurring Appointment/Event

This Outlook Training Session is only timetabled for today, but let’s say that it was running over 8 weeks - this is where the appointment/event can be made **recurring**, i.e. something that takes place at regular intervals.

1. Find in your Calendar the appointment that you’ve setup for the Outlook Training Session and double click on it to open it up
2. Within the **Appointment** window, click on the **Recurrence** icon in the **Options** group in the middle of the **Appointment** ribbon - you should see a window similar to below:

![Appointment Recurrence Window](image)

3. There are a number of options that can be changed, but in this case you only need to change the date that the recurring event ends - click in the radio button (circle) to the left of **End after:** and change the value from 10 to **8** in the box to the right
4. Click **[OK]** and then click on the **Save & Close** icon on the ribbon

You might find that there is now a recurrence symbol in the Outlook Training Session appointment (bottom right-hand corner - it depends on the size of the box). If you now open this recurring appointment, you will see the following prompt:

![Open Recurring Item Window](image)

You can decide to make a change just to this one occurrence of the appointment, or you can make the same change to all the appointments in the series. In this case, **[Cancel]** as you’re not going to make any changes.
Changing the Calendar Layout, View and Other Defaults

Working with the Date Navigator

The Date Navigator (the mini-calendar in the top-left of your Outlook window) shows you the current month by default, and any numbers in bold indicate that there is an appointment/event on that day of the month. You should see this for the recurring appointment that you’ve just setup.

There are also arrow keys at the top of the Date Navigator (to the left and right of the month) that allow you to move forwards to the next month or backwards to the previous month. You can change the layout of the Date Navigator so that it appears on the right-hand side of the Outlook window, and you can expand it to show just more than the current month as follows (this could be useful if you wanted to move or copy an appointment from the current month to a future month):

1. Click on the View tab at the top, followed by the To-Do Bar icon about halfway along the ribbon in the Layout group, and choose Normal

This will move the Date Navigator to the right-hand side of the Outlook window, and below it will show the next few appointments that you have followed by any tasks that you have setup. You can modify the layout in the To-Do Bar further through the icon on the View ribbon by switching the individual components on or off (i.e. date navigator, appointments and task list) or choosing Options... (for example this can be changed to show more than 1 row of months)

2. To expand the Date Navigator so that you can see more than 1 month horizontally, rest the mouse pointer on the split bar to the left of the Date Navigator. When the pointer becomes a double-headed arrow, drag the pointer to the left until you see two columns of little calendars for this and next month. It’s up to you how many months you want to show, but this is how it would look if you've set it up this way:

![Date Navigator Expanded](image)

Note: You can also turn an email message that you receive into an appointment (or meeting) on your Calendar by dragging the message onto a particular date on the Date Navigator (the appointment is set to the first available slot on that day, with the subject the same as the subject of the email, and the email message filling out the description of the appointment).
Changing the Calendar View

At the top of your calendar, just above the dates, on the Home ribbon within the Arrange group, you have buttons that can switch between the calendar views for Day, Work Week, Week, or Month. Try these out to see the difference. Return to Day or Work Week view by clicking on the appropriate button.

Within the Day and Week views, the default time interval for appointment slots is 30 minutes, but you can change this by right clicking in the area where the times are shown to the left of the appointment slots, and choosing the time interval, say 15 minutes, that you want instead from the shortcut menu.

Other Calendar Defaults

To see some of the other Calendar defaults that have been setup:

1. Click on the File tab in the top left-hand corner, followed by Options on the left and finally Calendar on the left in the Outlook Options window to see the following:

![Calendar Options Window](image)

Here you can:

- Customize your work week if you work part-time or night shifts (appointments can still be setup out of normal working hours). Set the appropriate times in the Start time and End time boxes and select the check boxes for the desired working days. You can also change the First day of week if you don’t start work on a Monday.
- Under Calendar options, you’ll see the option to change the time of the Default reminders or remove it completely by unticking it.
- Allow or not allow attendees to propose new times for meetings that you setup, and the default response if it is allowed.
• An [Add Holidays...] button - the default for your Calendar is to include UK holidays, but if you also want to include holidays from another country or religious holidays, then this is where you would set this up

• A [Free/Busy Options...] button where you can setup and/or change permissions to your calendar. The default permission is set to Free/Busy time, but this can be changed. Note that if you are sharing your calendar with other people then you will see the names of those people and their permission level to your calendar. Within the Calendar Properties window, there is an [Other Free/Busy...] button and if you click on this then you can change how many months of your calendar people can check to see if you’re available for a meeting (they will only see if you’re free or busy, but not the details of your appointments, although there is a permission level that does show the subject and location). The recommendation is to set this to 12 months

• Under Display Options, you can change the Default calendar colour, usually blue at the start - particularly useful if you are looking at more than one calendar and need to distinguish between them. To see further options, you may need to vertically scroll down the Outlook Options window

• A Time Zones section which allows you to show you the time as it is in another country (show a second time zone) - this might be useful if your work involved travel abroad

Organising a Meeting

This is probably one of the areas that most people are interested in when they hear about Outlook. Organising a meeting is not that difficult to do, but finding out the dates/times when other people are available is more difficult and not always possible. Let’s see how one would go about organising a meeting (it’s really a special type of appointment) - firstly, you need to start with a possible meeting time/date and choose your attendees:

1. Click in the main Calendar grid to select the time for your meeting, say later today or tomorrow (you need to have the Calendar in Work Week or Week view) - this area should turn blue

2. Right click on the blue area and choose New Meeting Request to get the following:
3. You are the only attendee at present (as you are the organiser!). To invite other attendees, click on [To...]

In the **Select Attendees and Resources** window that appears:

4. Click on the **dropdown list arrow** under **Address Book** and choose **Global Address List**

When sending emails to staff colleagues within the University of Reading, it is recommended that you use their **Reading University email address** that is within the **Global Address List**.

The Global Address List contains a list of all the users and groups that have accounts on the Exchange server. The majority of University staff have now been moved to Microsoft Outlook on Exchange.

One of the **main advantages** of using the Global Address List is that when you setup a meeting and send out meeting invitations, you will be able to use Outlook’s **Scheduling Assistant** to see when your colleagues are **free** to attend your meeting (assuming that they are also using Outlook and keeping their Calendar up-to-date).

The list is shown in alphabetical order of the first name or first initial of the person which isn’t very helpful! A better way of searching is:

5. Click on the **More columns** radio button just above the Search box

6. Type in your search term, e.g. the surname of a colleague you want to come to the meeting, and click [Go] or press <Enter>

7. Select the name that you want from the list of search results and then click on the [Required] or [Optional] button at the bottom of the window

8. Let’s also invite someone else as an **optional attendee** to the meeting so search for the surname of another colleague or, if you are on an Outlook training course, one of your neighbouring trainees

9. Click on the [Optional] button just below [Required]

10. Click [OK]
Checking the Scheduling Assistant

You are returned to the **Untitled - Meeting** window with the names of your attendees now showing in the box to the right of [To...]. On the right in the **Room Finder** and at the bottom it should be showing **Suggested times** (you may need to scroll down to see more of these). If your original chosen time is shown here as a **conflict** then this means that at least one of the attendees cannot make it. If there is another time that is shown as **No conflicts** then this would be a better one to choose as everybody can make that time.

An alternative way to view whether your attendees can make the suggested date and time is to use the **Scheduling Assistant**:

11. Click on the **[Scheduling Assistant]** icon on the ribbon – something similar to the following window appears:

![Scheduling Assistant Window](image)

You should now be able to check more visually if your attendees are free to come to your meeting. Hopefully, you will be able to see the **free/busy time** information for yourself and your meeting attendees. If you find the **Room Finder** pane is in the way on the right of your window, just close it down by clicking on the [x] next to Room Finder.

**Note:** If you see ‘slashes’ across the schedule for a particular attendee, this indicates that there is no free/busy time information available for that attendee. This could be because the attendee does not use Microsoft Outlook on Exchange, or that they haven’t yet used the Calendar to make any appointments.

If the currently selected time for the meeting is no good as one of your attendees is busy or out of the office at that time, then you can also move the time slots (the green and red vertical lines) with the mouse or change the meeting start and end times to find the next available free time.

The final steps are to fill in more details about the meeting and then send off invites:

12. Click on **[Appointment]** on the ribbon at the top
13. Fill in the details for subject (e.g. Paul’s Test Meeting, but **put your own name** so you can recognise your own meeting later!), location and description, a bit like below:

![Meeting setup](image)

Note the [Rooms...] button – in the future it is hoped that this will be used to access central rooms across campus in which you can book a meeting.

14. If you wanted to attach a file to your meeting, click on the **Insert** tab at the top and then the [Attach File] icon to choose the file that you want to attach

15. Click on [Send]

You should find that a Test Meeting entry has been put into your Calendar.

You will now have to wait to see if your attendees accept or decline the invitation to your meeting!

You can keep a track on this by:

16. Opening up the Meeting item on your Calendar

17. Click on the **Tracking** icon in the **Show** group on the **Meeting** ribbon - here you can see if any of your attendees have responded yet

18. Close the **Meeting** window

### Dealing with an Invitation to a Meeting

As well as inviting people to your meeting, if you are on an Outlook training course, you should also find that you have been invited by email to another meeting by one of your trainee neighbours!

1. To look at your email, click on the **[Mail]** button in the Navigation Pane (usually in the bottom left-hand corner of the Outlook window)

2. Click on the message about the meeting - it should look a bit like below:
You have the following choices:

- **Accept** a meeting that you know you’ll be able to attend. When you accept a meeting, the meeting is scheduled in your Calendar and you receive updates if the meeting organiser changes the details of the meeting. If others view your free/busy time, the time appears as Busy by default.

- **Tentative** - use this option if you're interested in the meeting, but aren't sure whether you'll be able to make it. The meeting is scheduled in your Calendar and that block of time is displayed to others as tentatively unavailable.

- **Decline** a meeting if you can’t go. Declining a meeting deletes the item from your Calendar (freeing that block of time), but it does not cut your ties with the meeting: You’ll still get updates if the meeting organizer makes them and you’ll have the opportunity to respond to the update. (If you truly want to opt out of a meeting, you may want to ask the organizer to remove your name from the attendee list).

- **Propose New Time** - when you choose this and propose a new time, the meeting organiser receives your request... but as with all things about the meeting, the organiser gets to make the final decision about the new meeting time. Note that this option might not be available if the meeting organiser hasn’t allowed attendees to propose new times.

- **Calendar** – to check your calendar in a new window.

3. Click on the [Accept] button at the top of your invitation to see the following options:

   ![Edit the Response before Sending, Send the Response Now, Do Not Send a Response]

4. Go with the 2nd option of **Send the Response Now**

   If you wanted to **Edit the Response before Sending**, e.g. to say that you’ll be late for the meeting, then choose that option. The last option is not one that you should usually choose (as you won’t get any updates about a possible changed meeting time).

5. Go back to your Calendar by clicking on the [Calendar] button in the Navigation Pane - you should find an entry for the meeting from another training attendee has been added.

**Using the Email System**

Most, if not all, of you should already be familiar with using email. The next sections will show a few things that you might not already know or that are specific to email in Outlook.

**Adding a Signature**

An automatic signature can be set up so that when you send a message, contact information about you is automatically put at the bottom of your message without you having to type it every time. It is often useful to include your name, your role at the University, a contact phone number and the web address of your School/Department/Unit.

A guide to creating professional, effective signatures can be found in [Email Signatures](http://www.reading.ac.uk/internal/its/help/its-help/email/its-help-emailsignature.aspx).

Try setting up your own signature as follows:

1. Click on the **File** tab in the top left-hand corner, followed by **Options** on the left and finally **Mail** on the left in the Outlook Options window.
2. Under the **Compose messages** section at the top, click the **[Signatures...]** button on the right.

3. In the **Signatures and Stationery** window that appears, click on **[New]** (if you want to create a new signature). Enter a name for your signature, e.g. **work**, and click **[OK]** (you could have one signature for work messages and a different one for personal messages).

4. Type in the information that you want in your signature. Let your email client use it’s ‘default’ or ‘body’ font for your signature (there are formatting options to use different fonts, put on bold etc.). An example of how a signature might look is given below:

5. Click on **[Save]** to save the new signature.

6. Create a **second** signature for **personal** use, repeating steps 3 - 5 above.

7. Setup **work** as the default signature for **new messages** by clicking on the appropriate dropdown list arrow and then click on **[OK]**. Click on **[OK]** again back at the **Options** window.

8. The Calendar will probably still be showing from what was being done earlier - to get to the **Mail** in Outlook, click on the **[Mail]** button in the Navigation Pane, just above the **[Calendar]** button. You will be looking at your Inbox - there may already be a message of an acceptance to your meeting by one of the attendees.

9. Click on the **[New E-mail]** button (towards the top left-hand corner of your Inbox window) to send a message - you should now see your **work** signature at the end of your message.

**Tip:** If you want to change the signature in your message to a different one, e.g. your personal signature, just right click on the signature and choose the other signature from the menu.

**Using AutoComplete**

1. In the text box to the right of the **[To...]** button, type the **first** letter of the email address of an attendee to your earlier meeting - you should find that it has remembered the email addresses beginning with that letter. This is because **AutoComplete suggestion** has been turned on in Outlook. Select, using the mouse, one of the listed email addresses (if on training, this may be someone else on the class).

**Note:** AutoComplete suggestion is very useful, but sometimes it can be annoying as it may come up with email addresses that you may have only used once or no longer work. You can delete such an email address when the AutoComplete suggestion brings it up in the list (literally use the **<up>** or **<down>** arrow keys to select the address and press the **<Delete>** key on the keyboard). There is also an option to turn AutoComplete suggestion off completely via **File**, **Options**, **Mail**, then scroll down to the **Send messages** section and turn off the **Use Auto-Complete List to suggest names when typing in the To, Cc, and Bcc lines** check box. There is also an **[Empty Auto-Complete List]** button if you want to remove the email addresses from the list.
Another option in the same area that says **Commas can be used to separate multiple message recipients** should be turned on to allow for cases where email addresses are being copied from another system to Outlook, e.g. the RISIS system, specifically where a tutor wants to send emails to students on a particular RISIS module.

You are going to send a carbon copy of the new message to your own email address. Note that Outlook is usually setup to save a copy of every message you send in a Sent Items folder (you can turn this off or save to a different folder via the Options ribbon for a new message).

1. Click on the [Cc...] button

In the Select Names window that appears:
2. Click on the dropdown list arrow under Address Book and choose Global Address List
3. Click on the More columns radio button just above the Search box
4. Type in your surname and click [Go] or press <Enter>
5. Select your full name from the list of search results (you may need to scroll down) and then click on the [Cc] button at the bottom of the window

**Note** the [Bcc] button below the [Cc] button. Bcc stands for *Blind Carbon Copy*, and means that other people who receive the message will not know that it has also been sent to the blind carbon copy email address. This can be useful in the case where you want someone to get this message, but not allow the other receivers to know who this someone is. It can also be used when you're sending a message to a large number of people, but be aware that this is **not** normally recommended practice as it is a technique often used by spam mailers (it's better to setup or use a mail list with a specific email address).

7. Click [OK]
8. Type in a subject for your message, write a short message and click on [Send]. You should receive a copy of this message in your Inbox as you Cc'd it to yourself

**Note:** You may find that when you first use your Exchange account, no emails seem to be arriving there. If this is the case then see the section under Email in the Microsoft Exchange FAQ (http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/exchangefaq.aspx).

### Setting which Address List Shows First

When you opened up the Select Names window above to choose who to send an email to or who to invite to a meeting, it is recommended that it is set to look at the Global Address List on opening. This could be changed to look at your Outlook Contacts folder on opening. If the Global Address List isn't your default, and you want it to be:

1. In the main Outlook window, click on the [Home] tab followed by Address Book (on the right of the ribbon)
2. In the Address Book window, you’ll see some menus at the top. Choose **Tools** and then **Options**... to see a dialogue box like below:

![Addressing dialogue box](image)

3. In the Addressing dialogue box, select **Global Address List** from the **Show this address list first** drop-down list (you can also change the order in which address lists are checked on sending)

4. Click **[OK]** and then close the Address Book window

**Tips on Using your Mailbox**

Here are some tips that you may find useful.

**The Reading Pane and Preview**

You will probably find that you can already see the content of one of your messages (the currently selected one) in your Inbox towards the right of your screen (just to the left of the To-Do bar if you have this showing). This is because the **Reading Pane** is on by default. This is good for security as you can view messages safely in the Reading Pane. Potentially malicious scripts or attachments are not activated or opened automatically in the Reading Pane. If you want to change the settings for the Reading Pane:

1. Click on the **View** tab at the top
2. Choose **Reading Pane** under the **Layout** group on the **View** ribbon
3. Select **Right**, **Bottom** or **Off**

From the above, you can see that you can have the Reading Pane below or to the right of your messages in the Inbox, or turn off the Reading Pane completely (in this case, you would need to double click on a message in the list to open it in its' own window). There are also further Reading Pane options such as how long it takes for a message to be marked as read.

A further refinement is to have **Preview** turned on. This allows you to preview the first three lines of messages in your Inbox, and so gives you some idea of what the message contains before you look at it in more detail. To do this:

1. Click on the **View** tab, followed by **Change View**, and then **Preview**
This will apply to just the **unread** messages in your Inbox. If you want it to be shown for all messages or to be turned off then:

2. From the **View** tab, click **View Settings** followed by the **[Other Settings...]** button and a window similar to below should appear:

3. Under the **AutoPreview** section, click **Preview all items** or **No Autopreview** depending on what you want

4. Click **[OK]** 2 times

**Show as Conversations**

If you receive many e-mail messages daily, you could benefit from a grouping option called **Show as Conversations**. This view shows your message list in a conversation-oriented or "threaded" view. Each conversation can be expanded further to show all messages in the conversation, including messages you have already read, or collapsed. You can quickly review and act on messages or complete conversations.

To be able to see the above in action, you might need to reply to a message that a colleague has previously sent you. When you do this, choose **[Reply All]** so that you also get a copy of your reply.

The reply should now appear in your Inbox. By default, the messages are arranged by date with the newest on top. To turn on conversations:

1. Click on the **View** tab
2. Click on **Show as Conversations** in the **Conversations** group on the **View** ribbon
3. A prompt will appear asking you if you want to show messages arranged by conversations in just **[This folder]** or **[All folders]**. As we are trying this out, click on **[This folder]** so that only your inbox is affected
When showing conservations, your message list may look something like below:

If you click on the right arrow icon next to the subject of a message, then you expand the conversation so that you see the original message in the conversation and any replies underneath it. To collapse the conversation so that only the latest message appears, just click back on the arrow next to the subject.

**Using Coloured Categories**

You can setup different coloured categories to mark messages for certain topics or from certain people. To get to the categories when viewing your messages:

1. Click on the Home ribbon followed by the Categorize button (with 4 coloured squares) on the right of the ribbon and select All Categories...
2. The Color Categories window will give you the options to rename built-in categories, create new categories and associate the colours that you want with different categories
3. To apply a category to a message either use the above Categorize button or right click in the Categories column (the one with blank squares) within the message list and use the shortcut menu

You can then sort your messages on categories so that you can see the associated emails together. You can also use categories for marking other items such as appointments, meetings, contacts and tasks.

**Rules and Alerts**

You can setup rules and alerts for your emails that can be used to sort, redirect or delete emails as they come in, or to alert you to an email from a particular person. One way to setup a rule or alert is as follows:

1. Click on the File tab in the top left
2. Click on the [Manage Rules & Alerts] button to see something similar to below:

3. Click on the [New Rule...] to setup a new rule and follow the steps through until you finish. For further help on the steps and some examples of what sort of rules you could setup, see the Outlook Rules (http://www.reading.ac.uk/external/its/help/its-help-email/outlookrules.aspx) web page. You can also setup a rule for a particular message by right clicking on the message and choosing Rules or by using the [Rules] button on the Home ribbon.

Favourites

Here you can keep the folders that you use most often so that it’s much easier to find them and save messages into them. Let’s create a new folder, add that folder to the Favorites and save one of our messages in it:

1. To create a new folder, click on the Folder tab at the top followed by the [New Folder] button
2. In the Create New Folder window, type in a name for your new folder, e.g. A Test
3. Make sure you click on username@reading.ac.uk at the top of the list to select where to place the folder so as to save it at the top level of your mailbox (you can create mail subfolders)
4. Click [OK]

The new folder should appear in the list of mail folders under Favorites on the left-hand side (you may need to scroll down to see it). To move this new folder into Favorites:

5. Click on the new mail folder name
6. Click on the [Show in Favorites] button towards the end of the Folder ribbon

You should now find that a copy of the new folder is at the bottom of the Favorites. You can drag it to a different position in your Favorites list.

7. Save one of your messages into the new folder (just drag it across)

To remove a folder from the Favorites just click on the folder and from the Folder tab click on [Show in Favorites].
For Follow Up Folder

The folder named **For Follow Up** always contains an up-to-date list of all Quick Flagged messages in every folder in your mailbox. So you can use it to flag messages that you know need following up - in this way it can be used as a to-do list. To see how you can use this:

1. Looking at the list of messages in your Inbox, you should notice a faded/white flag to the right of each. Click on this **flag** next to one of the messages (not a meeting invitation) - you should find that it goes **red**.

2. If you look at your **To-Do Bar** on the right of your screen (**View** tab, **[To-Do Bar]** button, **Normal** to show it again), you should notice the new flagged message as a task at the bottom:

3. By **right-clicking** on the red flag next to the message, more options are available with different coloured flags standing for things like **Tomorrow**, **Next Week**, **Custom**... etc. Another option is **Add Reminder**... under which you can give a date and time for the reminder to be set. Click on this to get a dialogue box like below:

4. Change some of the details like the **Due date** and/or **Reminder** if you want and then click **[OK]**.

The **For Follow Up** folder is a special type of folder called a **Search Folder**, but it isn’t yet showing. To enable it to show:

5. Your **Search Folders** appear under **Mail Folders** on the left-hand side of your window. You may need to scroll down to see them and click on the **arrow** next to **Search Folders**.
Other Search Folders that may have been setup are Unread Mail, Categorized Mail and Large Mail. If you receive any attachments then you will find that another Search Folder called With Attachments is created.

6. Right click on Search Folders and choose New Search Folder...

From here you can choose from a list of pre-defined templates or create a search with custom criteria and save it as a Search Folder for future use.

7. To setup a For Follow Up folder, click on Mail flagged for follow up and then [OK]:

A For Follow Up folder should now be showing under Search Folders, and will contain a copy of the flagged message. This can be added to Favorites if you like.

**Blocked Attachments**

You will find that in Outlook there are certain files that will be automatically blocked if they have been sent as attachments. These include executable programs with an extension of .exe, Active Server Pages with an extension of .asp, and, perhaps more surprisingly, Microsoft Access related files including database files with an extension of .mdb.

If you receive a blocked attachment, you'll need to contact the sender and ask that person to resend the file using one of the following methods:

- **Link** to it - if you share a file server with the recipient, you can put the file there and send a link to the file rather than sending the file itself.
- **Zip** it into a zip-compressed file - you will need to have something to unzip it on arrival
- **Rename** it - you can rename the file and use a filename extension that Outlook won’t block, such as .txt. When you do this, you may need to include some instructions in your message on how to open the file.

For further details, open up the Outlook online help through the question mark icon at the top right of your window and search for blocked attachments.

**Away from the Office**

If you’re going to be away from the office on business or holiday, you should consider setting up an out of office message. A useful link that tells you what Out Of Office messages are for, what to

To setup an out of office message:

1. Click on the **File** tab in the top left
2. Click **[Automatic Replies]** - a dialogue box similar to below appears:

   ![Automatic Replies Dialogue Box]

3. Ensure that **Send automatic replies** is selected
4. If you know the exact times that you are away then tick the box to **Only send during this time range** and setup the **start** and **end** time
5. Write your autoreply message for people **Inside My Organization**
6. If it’s applicable to also write an autoreply message for people outside of the organization then click **[Outside My Organization (On)]**, tick the box to **Auto-reply**, choose between **My Contacts only** and **Anyone outside my organization**, and finally write your message
7. If you want to setup any rules for while you’re away, e.g. move particular emails to a specific folder, then use **[Rules...]**
8. Click **[OK]**

If you don’t set a start and end time, Automatic Replies will run until you manually turn them off. To do this:

- Click the **File** tab, and under **Automatic Replies (Out of Office)**, click **[Turn Off]**

Whilst you’re away, you can use [Outlook Web Access](https://www.owamail.reading.ac.uk/) to access your email at the University of Reading on any computer that has access to the internet.

If you wanted to allow somebody else to use your own Inbox whilst you’re away, then scroll down to the section under **Allowing access to your Inbox** on the [Exchange Mailbox Tasks](http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-mailboxtasks.aspx) web page
Using Contacts

This training course has mostly concentrated on using the Calendar and Email in Microsoft Outlook, but now let’s take a brief look at Contacts (for further information on importing address books and looking at the differences between contacts and address books, look at the online help within Outlook).

The sections below come from our Exchange Contacts web page (http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-exchange-contacts.aspx) which also tells you about the Global Address List, your address book, and setting up a distribution list or contact group.

Adding a New Contact

1. Click on the [Contacts] button in the Navigation Pane
2. To create a new contact, click on the [New Contact] button, the first icon on the Home ribbon

3. Enter in the information as required, either for yourself, a colleague or a friend:
   - You should enter a name in the box marked Full Name. If you click on the [Full Name] button then you can enter information regarding the user’s title, first name, last name etc.
   - Under File as: you can choose to store your contacts in either alphabetical order of the surname or the first name
   - There are three different email addresses that you can add, and these are displayed by clicking on the down arrow by the E-mail... box. You should enter at least one email address.
   - You can enter as much other information as you wish. Under Details in the Show group on the ribbon, you can store ‘important’ dates such as the contact’s birthday and wedding anniversary!
4. When you have finished adding information, remember to click [Save & Close], the first icon on the ribbon
Current View of Contacts

This can be set to a number of different views on the Home ribbon under Current View as shown below:

![Current View Options]

The three shown above are probably the most useful ones, i.e. By Category, Business Cards or Card.

Adding an Address from an Email

You can add someone to your Contacts if they have sent you an email as follows:

1. Click on the [Mail] button in the Navigation Pane and double click on one of your emails
2. Select the email address that you want to add and right click on it
3. Select Add to Outlook Contacts from the shortcut menu
4. A new contact box should open, and you can add as much information as before (note that the full name and email address have already been added)
5. When you have finished adding information, remember to click [Save & Close] and close the email message

Sending an Email to a Contact

To send an email to someone in your Contacts:

1. Click on the [Contacts] button in the Navigation Pane
2. Right click on the contact and choose Create followed by E-mail
3. Type in your subject and message and then send it to your contact

Setting up a Task

You might have noticed earlier that a to-do list could be setup using a For Follow Up folder. Another way of setting up tasks as a to-do list is as follows:

1. Click on the [Tasks] button in the Navigation Pane
2. There are a number of different views available for tasks. On the Home ribbon, click on the More arrow (▼) in the Current View group to get the following options:

![Task View Options]

3. Choose To-Do-List
4. Click where it says **Type a new task**

5. Type in something like **Look at further things to do in Outlook** and press `<Enter>` - you should find that this has now been setup as a new task

To add further details to the task, double click on it to open it up - you can then specify details such as the due date, the current status (e.g. not started, in progress etc.) and how much of it has been completed in percentage terms.

### Further Information

Here are some ways to get further information or help:

- Microsoft Outlook has its own **built-in Help** system, which contains a considerable amount of information as well as tips and examples. It can be accessed in a couple of ways:
  - Clicking on the **question mark icon 📚** at the top right of your window
  - Pressing key `<F1>` (usually located on the top row of the keyboard)

- A more advanced course, **Outlook 2010 Hints & Tips** ([http://www.reading.ac.uk/web/FILES/its/Outlook2010Tips.pdf](http://www.reading.ac.uk/web/FILES/its/Outlook2010Tips.pdf)) has been developed which has hints on sending emails, organising email, sharing information and the Calendar

- Further documents on using Microsoft Outlook at the University are available from the IT Services **Staff Email Documentation** web page ([http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-staff-email.aspx](http://www.reading.ac.uk/internal/its/help/its-help-email/its-exchange/its-staff-email.aspx))